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This guide explains how to implement MiCollab Advanced Messaging (MiCollab AM) Unified Messaging 

for IBM Notes and Domino.  

This guide is written for Mitel-certified administrators and technicians who are familiar with MiCollab 

Advanced Messaging (MiCollab AM) procedures and terminology, the MiCollab AM Admin utility, and 

the Microsoft Windows® operating system. 

Before implementing any procedures in this guide, ensure that MiCollab AM software is installed and 

running successfully. 

These instructions assume that you have installed a MiCollab AM System Server integrated to either an 

XMediusFAX fax server or an Open Text® RightFax® Enterprise fax server and that all systems are 

operating successfully.  

NOTE This guide assumes that the IBM Domino Server is installed on a platform running the Windows 

Server 2012 R2, Windows 2016 (Server with Desktop Experience), Windows Server 2019 (Server 

with Desktop Experience), or Windows Server 2022 (Server with Desktop Experience). operating 

system. 

References 

A catalog of technical documentation is included on the MiCollab AM Installation Media. If you are 

installing any advanced applications, such as Networking and Fax Server applications, you should refer to 

the appropriate technical documentation for application and installation information. 

Documentation 

The technical documentation is produced in the PDF format and requires the PDF reader to view it. The 

MiCollab AM Documentation Library includes the following documents and resources: 

 Administration Documentation. Available as a PDF only. Contains the following: 

 Administration Guides. Available as a PDF only. Contains administrative guides for 

administrators about how to manage and configure the messaging system. 

 Quick Reference Cards (QRC). Contains shortcuts and quick instructions telling subscribers 

how to access and use the messaging system. 

 User Guides. Available as a PDF only. Contains user guides for subscribers about accessing the 

messaging system and checking and sending messages. 

 Server Documentation. Available as a PDF only. Contains the following: 

 Developer Resources. Contains programming guides and API references for developers for 

integrating the server clients and web applications with MiCollab AM. 

Preface 
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 Installation and Configuration. Available as a PDF only. Contains installation and 

configuration guides for server administrators about how to install and configure the 

messaging system. 

 Integration Technical Notes (ITN). Contains a set of guides that describe the integration 

methods and instructions for a variety of phone systems to work with MiCollab AM. The ITNs 

are generally used by resellers or administrators who are experienced with MiCollab AM and 

familiar with the integration procedures and terminology. 

 Spare Parts Documentation. Contains a set of guides that describe the instructions for 

installing and configuring hardware parts to work with MiCollab AM. These documents are 

written for Mitel-certified MiCollab AM technicians who are experienced with MiCollab AM and 

familiar with the procedures and terminology. 

 Software Release Notice (SRN). This notice introduces the new features, capabilities, and 

hardware/software requirements for the corresponding MiCollab AM version. 

Documentation Updates 

Documentation updates may be available from the following sources: 

 Mitel-certified technicians can view or download documents and program files from our partner 

web site: www.mitel.com  

Help 

The primary source of information about MiCollab AM is the online help available within any of its 

administrative utilities. You can access Help by clicking the Help button in the dialog box or window in 

which you are working. 

Document Conventions 

The following conventions are used in this document: 

 Key Names. Names of keys on the keyboard are shown in a box. 

Example: -Enter- 

When two keys must be pressed simultaneously, they are joined by a + sign. 

Example: -Alt- + -Tab- 

 Reference to Document Titles of other documents are shown in italics. 

Example: See the System Installation and Configuration Guide. 

 User Interface (UI) Element Names. Names of UI elements such as dialog boxes, windows, screens, 

menu items, tabs, buttons, and icons are shown in bold.  

Example: On the Startup screen, click the Start icon. 

http://www.mitel.com/
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 User Input. Information required to be typed is shown in italics. 

Example: Type the password voicemail. 

 Warning, Caution, Important, and Notes. Text for the contents that require attention are shown as 

follows:  

WARNING A warning paragraph advises you of circumstances that can result in the loss of data, 

harm to the MiCollab AM System Server platform, or personal harm. 

CAUTION Failure to follow these recommendations can result in unauthorized access to the 

system and consequent loss of data. 

IMPORTANT An important paragraph gives decision-making information or informs you of the 

order in which tasks need to be completed. 

NOTE A note gives additional information, provides an explanation, or indicates an exception to 

the information in the preceding text. 

 

For more related documents, refer to the following list of references: 

Table 1. References 

Document Type Document Title 

Administration Documentation System Administration Guide 

Server Documentation System Installation and Configuration Guide 

Server Documentation XMediusFAX Integration Guide (optional) 

Server Documentation RightFax Integration Guide (optional) 

Server Documentation Faxtext for RightFax Administration Guide 

Server Documentation Fax Messaging for RightFax Administration Guide 

Quick Reference Card Original TUI QRC 
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Frequently Used Terms 

Table 2. Frequently Used Terms 

Terms Description 

MiCollab AM System Server 

 

Term refers to an organization’s computer platform(s) that have 

MiCollab AM software installed and handles the core system functions 

such as storing messages, database. 

It can also refer generically to the MiCollab AM System Server 

platform, the Call Server platform, or both. The term is most often used 

to describe a software or hardware installation or configuration 

practice where the role of the server platform is not specifically 

expressed. 

Call Server 

 

Term refers to an organization’s computer platforms that have 

MiCollab AM software installed and serve as the interface to the 

system (PBX). The Call Server(s) interface with the MiCollab AM System 

Server for the purpose of accessing messages, and database.  

MiCollab AM Unified 

Messaging 

Term refers to the MiCollab AM Unified Messaging for Lotus Notes 

and Domino client application, also known as Desktop Suite for 

Domino.  
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With MiCollab AM Unified Messaging for IBM Notes and Domino, subscribers can manage voice and fax 

messages along with E-mail messages in their IBM Notes Inbox folder. MiCollab AM Unified Messaging 

accomplishes this by enhancing the IBM Notes E-mail template so the features are seamless in an 

environment already familiar to subscribers. The concept of managing voice, fax, and E-mail messages 

within a single application program is referred to as unified messaging. 

MiCollab AM Unified Messaging stores all voice and fax messages in the user’s mail databases on their 

designated home IBM Domino Server. As each voice and fax message is received, it is moved from the 

MiCollab AM System Server automatically to the IBM Domino Server where it is accessible in its native 

form as a voice or fax message. Because the messages are stored on the IBM Domino Server, MiCollab 

AM Unified Messaging is referred to as server-based unified messaging. 

Successful implementation of MiCollab AM Unified Messaging requires the assistance of the following 

individuals, who make up the server’s implementation team: 

 MiCollab AM System Server administrator 

 IBM Domino Server administrator 

 If the organization uses a Windows Server domain, the domain administrator 

 MIS/IT support staff 

IMPORTANT It is recommended that you provide a copy of this document to each member of the 

implementation team several days or weeks prior to the implementation of the 

MiCollab AM Unified Messaging for IBM Notes and Domino integration. If your IBM 

Domino Server is running on a different operating system, please contact Mitel 

Technical Support for alternate installation instructions based on the operating 

system. 

MiCollab AM Unified Messaging Features 

In addition to supporting standard MiCollab AM features over the telephone, MiCollab AM Unified 

Messaging offers a number of additional features: 

 Allows subscribers to manage voice and fax messages in ways that best suit their work styles, using 

the familiar IBM Notes interface. 

 Allows subscribers to view and forward fax messages with voice or E-mail message attachments 

 Enables subscribers to create, listen to, reply to, and forward voice messages over a computer multi-

media sound system, without requiring a telephone. 

 Allows subscribers to record their name and greetings over a multi-media sound system on the 

subscriber’s workstation or telephone using Web PhoneManagerTM. 

 Allows subscribers to Live Reply to the sender of a message using the auto-dial feature (if supported 

by the telephone system) 

Overview 
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How MiCollab AM Unified Messaging E-mail Access 

Works 

With MiCollab AM Unified Messaging for IBM Notes and Domino, subscribers have two options for 

accessing their messages from the IBM Domino Server’s unified message store. They can use either the 

telephone user interface (TUI) or the graphic user interface (GUI) of the enhanced IBM Notes E-mail client. 

The IBM Domino Server tracks all the messages in the system. As messages are added and deleted, the 

IBM Domino Server updates its post office database. MiCollab AM E-mail Access communicates with the 

IBM Domino Server. When a subscriber has message notification enabled, E-mail Access polls the IBM 

Domino Server each time the subscriber logs on and periodically thereafter. 

If E-mail messages are present in the subscriber’s mailbox, E-mail Access generates an appropriate 

message to notify the subscriber. However, when a subscriber receives a new E-mail message, E-mail 

Access does not set the message-waiting indicator on the subscriber’s telephone. 

MiCollab AM must reside on the same local area network (LAN) that supports the site’s E-mail system. The 

LAN allows MiCollab AM and the E-mail system to communicate using the E-mail system’s application 

programming interface (API). 

 

Figure 1. E-mail Access and MiCollab AM Unified Messaging for IBM Notes and Domino 

E-mail Access is an advanced feature of MiCollab AM. It must be functioning before you can begin 

configuring MiCollab AM Unified Messaging for IBM Notes/Domino.  

NOTE For E-mail Access to function properly, all E-mail messages must be stored on the IBM Domino 

Server. E-mail Access cannot retrieve E-mail messages that are stored on the subscriber’s 

workstation. 

TUI Message Access 

With TUI access, subscribers can manage their E-mail messages by telephone using the MiCollab AM 

telephone user interface (TUI). They begin by logging into the MiCollab AM System Server, which then 
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checks their accounts on the E-mail server and enumerates their messages. MiCollab AM presents 

messages so that the subscribers can retrieve their information in the easiest way possible over the 

telephone: 

 Voice messages are played back directly. 

 E-mail messages are read aloud using text-to-speech capabilities, starting with information about 

the E-mail messages’ subjects and senders. 

 Fax messages are announced as such with their delivery dates, delivery times, and page counts, as 

well as the sender’s name if the sender was another subscriber. The subscriber must send the fax 

message to a fax machine for printing to view it.  

To improve message handling, subscribers can set MiCollab AM to present messages by type, allowing 

them to access specific types of messages quickly. Message access through the TUI does not support the 

creation of text or fax messages; it only supports voice forwards and replies to E-mail messages. 

TUI access offers the following features: 

 When subscribers log on, MiCollab AM notifies them if they have received E-mail messages and tells 

them how many new messages there are. In addition, depending on how the subscribers configure 

their mailboxes, MiCollab AM can inform them when new E-mail messages arrive. 

NOTE MiCollab AM E-mail message notification does not set message-waiting indicators (MWIs) 

on subscriber telephones. 

 Subscribers receive envelope information with each E-mail message. MiCollab AM can also report 

the message’s subject and read or play the sender’s name if the envelope information is available. 

 Subscribers can listen to their E-mail messages. The text-to-speech feature allows MiCollab AM to 

read aloud the content of an E-mail message, speaking each message’s subject, body, and any text-

based attachments using synthesized speech. 

 Subscribers can reply to E-mail messages with voice messages, providing critical responses without 

waiting to get to their E-mail programs. The response is attached to the E-mail reply message as a 

.wav file.  

The message recipient can listen to the voice message on any computer capable of playing .wav 

files, if the recipient’s E-mail server supports .wav attachments. 

NOTE Voice forwarding and voice reply options are supported only. Subscribers cannot input text 

or attach fax messages through the TUI when retrieving messages. 

 Subscribers can voice annotate an E-mail message before forwarding it to other server-based 

unified messaging users, enabling them to distribute information quickly.  

 When an XMediusFAX fax server or a RightFax Enterprise fax server is integrated with MiCollab AM, 

subscribers can forward E-mail messages by fax and print E-mail messages on any fax machine. In 

addition, text file attachments (with a .cmd, .bat, or .txt extension) can print to a fax machine, as can 

binary file attachments from such popular application programs as Microsoft Word® and Microsoft 

Excel®. 
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GUI Message Access  

During the installation of the MiCollab AM Unified Messaging software on client workstations, IBM Notes 

is modified to support voice and fax messages as follows: 

 New icons are added to the GUI. In the IBM Notes Inbox, a telephone icon signifies a voice 

message, whereas a fax sheet icon denotes fax and voice-annotated fax messages.  

 MiCollab AM messages are identified as such in the subject line.  

 New voice and fax message forms are included. The voice message form includes media player 

controls that support both the playback and recording of voice messages. The subscriber can select 

either the computer sound device or telephone for playback and recording.  

 Selecting a computer sound device allows subscribers to listen to, create, reply to, and forward 

voice messages without a telephone device. 

 Allows subscribers to set Call Blocking, Call Screening, and Extension Specific Processing (ESP), if 

those features are allowed for them. 

 Subscribers can annotate messages, adding information about the subject or notes that summarize 

the response. When the message is forwarded, these notes are not forwarded, but remain only with 

the original message. 

 Subscribers can forward or reply to any message using either MiCollab AM or E-mail message forms.  

Message Enumeration 

The user’s Inbox and Saved folders can be enumerated and the content of the E-mail messages read 

aloud. MiCollab AM enumerates and reads aloud any message found in the Notes user’s Inbox or Saved 

folders. It considers all messages in the Inbox folder, both read and unread, to be new messages, 

presenting them in separate read and unread groups over the TUI. It presents all messages in the Saved 

folder as saved messages. 

If a subscriber moves a message, regardless of type, to a IBM Notes folder other than Saved or Inbox, 

MiCollab AM is no longer able to access that message. 

New Messages 

All voice, fax, and E-mail messages in the IBM Notes Inbox folder appear as new messages through the 

MiCollab AM TUI. MiCollab AM preserves and reports the read or unread status assigned to messages in 

this folder. 

Deleting Messages 

When a subscriber uses the TUI to delete messages, they are marked for deletion on MiCollab AM but 

they are not deleted in the Notes mailbox until the subscriber logs off from MiCollab AM. At that point, E-

mail Access logs off from the subscriber’s Notes mailbox and the IBM Domino Server moves the marked 
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message to the Trash folder. The deleted messages remain in the Trash folder until the subscriber 

empties it.  

Saving Messages 

When a subscriber saves a message using the TUI, MiCollab AM informs the subscriber that the message 

is saved and for the duration of the telephony session, the message is held in the saved queue. When the 

subscriber logs off, MiCollab AM moves the newly saved messages from the Inbox folder to the Saved 

folder in the subscriber’s mail database on the designated home IBM Domino Server.  

The next time the subscriber logs on using the TUI, these messages remain available as saved messages. If 

the subscriber logs on to the IBM Notes Client, these messages are also available in the Saved folder. The 

read or unread status of messages in the Saved folder is not reported through the TUI; they can only be 

seen and changed in the IBM Notes Client. 

Text-to-Speech Rendering 

The From line, Subject line, and the body of all E-mail messages in the Inbox and Saved folders can be 

read aloud using the text-to-speech feature, including text file attachments (with a .cmd, .bat, or .txt 

extension). E-mail Access cannot find E-mail messages located in other folders. 

Message Notification 

Subscribers are notified of normal, urgent, and private priority E-mail messages, if normal, urgent, and 

private priority message notification is configured for the subscriber. 

Replying to Messages 

When a subscriber replies by either voice or E-mail to a voice or fax message, the original message is not 

included in the reply.  

 If the subscriber selects the voice reply option while using the GUI, a new voice form displays with 

the original sender’s E-mail address on the To line. Using the media controls, the subscriber records 

a voice reply. The reply can be edited or re-recorded before it is sent.  

 If the subscriber selects the E-mail reply option, the E-mail client uses its regular reply function. This 

allows the creation of a standard E-mail reply.  

 The Live Reply feature allows a subscriber to initiate a telephone call to the message sender of a 

selected voice, fax, or E-mail message in the Inbox. 

Voice Reply to E-mail Messages from Non-Subscribers 

In recorded voice replies to E-mail messages, the audio format depends on whether the person who sent 

the original E-mail message was a MiCollab AM subscriber. For other subscribers, MiCollab AM uses the 

format that its administrators have selected for voice messages. MiCollab AM uses linear, monaural, 8-bit 

PCM for non-subscribers. 
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On reply to an E-mail message from a non-subscriber, the voice message is attached to the reply message 

as a .wav file (linear PCM, 8 KHz, 8 bits per sample, mono). The recipient can then listen to this voice reply 

on a personal computer capable of playing .wav files. The E-mail server used by the recipient must 

support .wav file attachments. 

Forwarding Messages 

Subscribers can forward voice and fax messages as MiCollab AM voice messages, with or without a voice 

annotation. 

 If the subscriber selects the voice forwarding option while using the GUI, a new forward form 

appears. The subscriber has the option of recording an introduction to the original message. 

 If the subscriber forwards the message with the E-mail client’s standard forwarding function, a new 

mail message displays with one or two file attachments (a .wav file for a voice message, a .tif file for 

a fax). The subscriber may type text in the message or attach other files. 

NOTE When forwarding a voice message as an E-mail message from IBM Notes, any .wav 

attachment is formatted using a Pulse Code Modulation (PCM) compressor/de-

compressor (codec). This codec allows playback of the voice message on most computers 

running Windows-based operating systems, without requiring any special codecs to be 

installed on the computer. 

Modifying the Notes Field 

Subscribers accessing messages in the Inbox can add comments in the Notes field of any received voice 

or fax message and save those changes with the message. Such notes are intended for the subscriber’s 

personal use and are not included in any replies or forwarded copies of the message. 

Binary-to-Fax E-mail Attachment Rendering Support 

MiCollab AM supports the Server-Side Application (SSA) conversion engine used by RightFax Enterprise 

fax server versions 8.7, 9.0, 9.3, 10.5, and 10.6 Feature Pack 3. This support allows a subscriber using the 

TUI to forward an E-mail message with a binary file attachment, such as a Microsoft Word document, to 

any fax machine and get printouts of the E-mail message and binary attachments. Subscribers can print 

out binary file attachments in the file formats used by the following programs: 

 Microsoft Word 2000-2016 

 Microsoft Excel 2000-2016 

 Microsoft PowerPoint 2000-2016 

IMPORTANT The SSA feature is not supported on the same platform as MiCollab AM. SSA requires the 

installation of Microsoft Office products, such as Word and Excel, which are not allowed on 

the MiCollab AM platform. 

The SSA conversion engine can use the previously mentioned application programs to render binary file 

attachments from other application programs on any fax machine.  
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For a complete list of file attachment formats that the SSA conversion engine can render, and information 

about configuring the feature on the fax server, see the RightFax documentation. 

IMPORTANT Subscribers must use Fax Delivery mailboxes set up for callback delivery to retrieve E-mail 

attachments. For more information, see the Fax Messaging for RightFax Administration 

Guide. 

Third-Party Fax Server Support 

MiCollab AM can use either XMediusFAX or RightFax as its integrated fax server. In addition to these 

integrated fax servers, MiCollab AM Unified Messaging can support the following third-party fax servers: 

 Esker Fax™ 3.5 or later 

 Fenestrae® Faxination® 6.0 or later 

If MiCollab AM Unified Messaging is integrated with one of these fax servers, subscribers receive fax 

messages in their IBM Notes Inboxes and can view, forward, or reply to them as they would with 

XMediusFAX or RightFax. They also have the same ability to review, forward, and print their fax messages 

over the telephone. 

NOTE Faxtext is supported by both XMediusFAX and RightFax. For more information about setting up 

Faxtext, see the Faxtext for RightFax Administration Guide, XMediusFAX Integration Guide, and the 

RightFax Integration Guide. 

 Standalone Fax Messaging support requires RightFax. For more information about setting up Fax 

Messaging, see the Fax Messaging for RightFax Administration Guide and the RightFax Integration 

Guide. 
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MiCollab AM administrators should be aware of the following critical application issues concerning 

MiCollab AM Unified Messaging: 

 Message cache on MiCollab AM 

 Activity when the unified message store is unavailable 

 Message Waiting Indicators (MWI) on subscriber telephones 

 Time synchronization between servers 

 Supported e-mail server programs 

Message Cache on the MiCollab AM System Server 

When configured with MiCollab AM Unified Messaging, the MiCollab AM System Server caches voice and 

fax messages to speed subscriber access to messages through the TUI. Voice and fax message 

attachments are stored in the cache as the message is delivered to the inbox on the external message 

store. When accessing the message, if the attachment is located in the local cache, MiCollab AM will not 

need to download the attachment, reducing any potential delay during message playback. 

A server administrator can change the size of the cache by adjusting the E-Mail Cache Size (Mbytes) box 

on the Tenant Summary dialog box of the Tenant tab of MiCollab AM Configuration. Mitel 

recommends that the size of the cache be large enough that its automatic purge function is activated no 

more than once a day. An entry is recorded in the Windows event log each time the cache is purged. 

Activity When the External Message Store is 

Unavailable 

If the IBM Domino Server is unavailable to the MiCollab AM system, incoming voice or fax messages are 

saved to individual MiCollab AM Subscriber mailboxes. During this period of interrupted communication 

between the servers, subscribers can use the TUI to log on to MiCollab AM and check for messages that 

are received during the period of broken communication. MiCollab AM messages already moved to the 

IBM Domino Server’s unified message store are unavailable through the TUI until communication between 

the servers can be restored.  

If the IBM Domino Server is functioning, a subscriber can retrieve voice and fax messages stored on the 

IBM Domino Server using the IBM Notes Client. Voice messages residing on the MiCollab AM System 

Server are unavailable through the IBM Notes Client. Once the two servers restore communication, the 

MiCollab AM System Server moves the new messages still residing on it to the IBM Domino Server and all 

messages are available through the TUI or the IBM Notes Client. 

Critical Application Issues for MiCollab 

AM Administrators 
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Message Waiting Indicators on Subscriber Telephones 

IMPORTANT The Message Waiting Indicator (MWI) feature requires that the IBM Domino Server be 

installed on a platform running the Windows Server 2012 R2, Windows Server 2016 

(Server with Desktop Experience), Windows Server 2019 (Server with Desktop Experience), 

or Windows Server 2022 (Server with Desktop Experience). operating system. 

After the installation and configuration of MiCollab AM Unified Messaging, new voice and fax messages 

activate the MWI on subscriber telephones. This is true of both visible and audible MWIs. In addition, 

subscribers are notified of new messages through the IBM Notes Client’s new message indicator or, if they 

are checking messages by telephone, by the MiCollab AM prompts.  

If subscribers manage mail through local replication, MWIs may not be supported. Subscriber and mail 

databases must be located on the IBM Domino Server for the MWI feature to work. 

NOTE The Immediate Message and Daily Message Notification features are available with MiCollab 

AM Unified Messaging. Short Message Service (SMS) notification applies only to messages stored 

on the MiCollab AM System Server. 

Time Synchronization between Servers 

It is critical that the time settings on the MiCollab AM System Server match the time and time zone 

settings on the IBM Domino Server. You can match these time settings by using a time synchronization 

program that automatically updates the time on both servers or by manually updating them.  

If the times on the two servers lose synchronization with each other, then a new message sent from the 

MiCollab AM System Server to the IBM Domino Server may appear to be a future delivery message. If this 

occurs, then the message may fail to appear in the E-mail client program right away or be presented 

through the TUI until the future delivery time has arrived. 

Time differences between the MiCollab AM System Server and the IBM Domino Server can cause a 

disparity between the messages displayed in the E-mail client and the messages available in the TUI. 

Mitel recommends that you use the Windows Time Service in the operating system’s Control Panel to 

synchronize the time between the MiCollab AM System Server and the IBM Domino Server. Windows 

Time is a background Service that synchronizes the time on Windows Servers on the network. 

For additional information about using Windows Time, see the appropriate Microsoft Windows Server 

documentation. 

Supported E-mail Server Programs 

MiCollab AM E-mail Access supports the global releases of the IBM Domino Server Family with Domino 

Mail Server Releases 9.0.1 or previous. Newer versions of IBM Domino Server are tested and approved as 

required.  
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This section lists the configuration requirements for successfully enabling E-mail Access and MiCollab AM 

Unified Messaging. Be sure to review and meet these requirements before continuing with the other 

procedures discussed in this document. For more information on hardware and software requirements, 

see the Software Release Notice version 23.2. 

Installation requires you to install a number of files on the IBM Domino Server and on each subscriber 

workstation. 

IBM Domino Server Requirements 

 Windows 2012 R2, Windows 2016 (Server with Desktop Experience), Windows Server 2019 (Server 

with Desktop Experience), or Windows Server 2022 (Server with Desktop Experience). 

 Domino version 8.5.1 (32 and 64 bit), 9.0, or 9.0.1 FP 10 Interim Fix 5 

 Lotus Notes version 8.5.1 (32 and 64 bit), 9.0, or 9.0.1 FP 10 Interim Fix 6  

 To use the new subscriber search capabilities of E-mail Access, the Lightweight Directory Access 

Protocol (LDAP) Service must be running on the IBM Domino Server configured for access in the 

MiCollab AM Profile. The LDAP Service must be installed and configured to permit access through 

an anonymous logon. 

NOTE When a user searches messages, the IBM Domino Server searches messages for the past 10 

days only. Messages older than 10 days are not searchable. 

MiCollab AM System Server Requirements 

 MiCollab AM version 23.2 

 Windows Server 2012 R2, Windows Server 2016 (Server with Desktop Experience), Windows Server 

2019 (Server with Desktop Experience), or Windows Server 2022 (Server with Desktop Experience). 

 MiCollab AM feature file update with E-mail Access and text-to-speech conversion channels enabled 

NOTE MiCollab AM Unified Messaging for the Lotus Notes and Domino server is not supported in 

a multi-tenanted system. 

 Network connection to the LAN on which the IBM Domino Server is connected 

 Installation of the correct network protocols to communicate with the IBM Domino Server 

 IBM Notes client software version 8.5.1 FP3, 9.0, or 9.0.1 FP10 

Configuration Requirements for 

MiCollab AM and IBM Domino Server 
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NOTE The IBM Domino Server software and the IBM Notes client software on MiCollab AM should 

be the same version. 

Optional MiCollab AM System Server Requirements 

 To print E-mail messages on a fax machine (E-mail text-to-fax service), either the XMediusFAX fax 

server or the OpenText RightFax Enterprise fax server must be installed at the site. See the 

XMediusFAX or RightFax documentation for requirements. 

 To print binary file attachments, such as Microsoft Word documents, RightFax Enterprise fax server 

Version 23.2 or later must be installed at the site, but not on the MiCollab AM System Server. See the 

RightFax documentation describing the SSA conversion engine. 

 To read the content of E-mail messages and text-based attachments aloud using synthesized 

speech, text-to-speech channels must be purchased.  

 Only one subscriber can use a text-to-speech channel at one time.  

 To determine the number of text-to-speech resources the MiCollab AM System Server is 

currently licensed, the server administrator can refer to the Features tab in MiCollab AM 

Configuration.  

NOTE Text to speech channels are licensed by Mitel; you must purchase text-to-speech channels. 

For more information, contact Mitel Sales Engineering. 

Client Workstation Requirements 

Depending on their system configurations, client workstations can process messages using the IBM Notes 

E-mail client or IBM iNotes.  

Client Workstations with MiCollab AM Unified Messaging 

 Microsoft Windows 7, 8/8.1, or 10 

 IBM Notes client software version 8.5.1 FP3, 9.0, or 9.0.1 FP10 

 MiCollab AM Unified Messaging Desktop Suite 23.2 for IBM Notes and Domino  

Workstation Client with Web Browser Access 

 Microsoft Windows 7, 8/8.1, or 10 

 Optional Mitel media player 

 Microsoft Internet Explorer 9 or later 

NOTE Contact IBM for a complete list of supported web browsers. 
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IMPORTANT The IBM Domino Server administrator performs these tasks. See the IBM Domino Server 

documentation for additional instructions. 

This section briefly outlines the steps necessary to enable the IBM Domino Server E-mail Access interface. 

For successful installation and operation, the following items are required: 

 MiCollab AM is fully operational 

 IBM Domino Server is fully operational 

 IBM Notes client software with one user license installed on the MiCollab AM System Server 

 Windows Server operating system software (optional) if additional network protocols need to be 

installed on a Server platform 

To enable the IBM Notes interface for MiCollab AM operations, the IBM Notes/Domino administrator and 

the MiCollab AM administrator must perform the tasks on the following pages.  

Configuring the Lightweight Directory Access Protocol 

To use the Lightweight Directory Access Protocol (LDAP) features, configure the LDAP protocol to 

start automatically and to support anonymous queries. This Service must be running on the IBM Domino 

Server configured for access in the MiCollab AM Profile. 

Operation of this feature depends upon the E-mail system to which MiCollab AM is connected. MiCollab 

AM does not depend upon LDAP for E-mail Access operation. The feature is provided to aid the MiCollab 

AM administrator with mailbox configuration. Without LDAP, the MiCollab AM administrator must provide 

exact Subscriber mailbox information and enter the information without typographical error. 

NOTE The Verify button neither uses nor verifies the Logon ID or password for any profile type, when 

the server type is set to Notes. 

Creating the Voicemail Profile User on the IBM Domino 

Server 

The MiCollab AM System Server requires a IBM Notes client installation to interface with the IBM Domino 

Server. This section will step you through the creation of an IBM Notes user account for MiCollab AM Mail 

Access.  

Configuring IBM Domino Server for E-

mail Access 
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NOTE The voicemail profile user accesses mailboxes on the Domino external store for the subscribers 

using the Unified Messaging or E-mail Access feature.  

To create a voicemail profile user on the IBM Domino Server: 

1 Start the IBM Domino Administrator Client and log on if necessary. 

2 Under the File menu, select Open Server and select your IBM Domino Server. 

3 On the People & Groups tab, under the Tools dropdown list, click People, and then click Register. 

4 In the Enter Password dialog box, type your certifier password, and then click OK. 

5 In the Last Name box within the Register Person dialog box, type the name of the voicemail 

profile user. (Be sure to keep the name consistent throughout the installation.) 

6 Type a password in the Password box. (The password is also required later.) 

7 Select Advanced. 

8 Determine if the user ID should be stored as an ID file. 

 If you want to store the user ID in an ID file, continue to Step 9. 

 If you do not want to store the user ID in an ID file, skip to Step 12. 

9 Click ID Info.  

10 Click In File, and then click Set ID File to select the desired location folder. 

11 Locate the desired location folder, and then click Save to accept the location. 

12 To add the user ID to any groups, click Groups, and then add the user ID to any groups desired. 

13 If all the other settings are correct, click Add Person. 

14 Click Register. This processes the request and creates the user. 

15 Click Done when you are finished. 
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Enabling E-mail Access 

This section discusses how to successfully enable E-mail Access on the MiCollab AM System Server. It 

assumes that both the LAN and MiCollab AM are functioning properly.  

The E-mail Access feature allows the user to retrieve the emails from their subscriber email mailbox via the 

Telephone User Interface (TUI) or Voice User Interface (VUI). E-mail access requires an email profile to be 

selected and a mailbox and display name to be provided on the E-mail tab of MiCollab AM Admin; 

however, it does not require the selection of the Unified Messaging option. 

Enabling E-mail Access Globally 

You must enable E-mail Access to allow MiCollab AM to communicate with Notes/Domino. By enabling E-

mail Access globally, you prepare the MiCollab AM System Server to link with the IBM Domino Server. 

To enable E-mail Access globally on MiCollab AM: 

1 Log on to MiCollab AM Admin. 

2 From the menu bar, go to Configuration > System. 

3 Select the Messaging tab. 

4 Select the E-mail Access Active check box. E-mail Access does not work if this box is cleared. 

5 Click OK to close MiCollab AM Admin. 
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NOTE Although these instructions specifically state MiCollab AM System Server, for TUI access to 

messages, these steps must also be performed on all call server nodes as well. To ensure proper 

TUI access for messages, please execute these steps on the Call Servers. 

The IBM Domino Server administrator performs these tasks. The MiCollab AM Service must not be 

running while you complete this task.  

Installing the IBM Notes Client on the MiCollab AM 

System Server 

To install the IBM Notes Client on the MiCollab AM System Server: 

NOTE Installing the IBM Notes Client on the system server requires a restart of MiCollab AM before the 

IBM Notes Client can be used. 

1 Log on to the MiCollab AM System Server using the MiCollab AM Service account. 

2 Open MiCollab AM System Configuration, and select the Main tab. 

3 If the system is running, click Shutdown. Wait until Current Status changes to Stopped.  

4 Close MiCollab AM System Configuration. 

5 Start Setup for the IBM Notes client. 

6 At the Welcome dialog box, verify that no other programs are running, and then click Next. 

7 At the License Agreement dialog box, read the license agreement, select I accept the terms of 

the license agreement, and then click Next. 

8 In the Organization field, type the name of the voicemail profile user previously registered, as 

appropriate. 

9 Verify that the Only for Me option is selected, and then click Next. 

10 At the Installation Path Selection dialog box, use the Change buttons to alter the installation 

location as follows: 

IMPORTANT drive must represent the drive letter of a valid physical disk drive on the MiCollab 

AM System Server platform. Do not use any other installation location. 

 Install Program files to drive:\Lotus\Notes\ 

 Install Data files to drive:\Lotus\Notes\Data\ 

Configuring the MiCollab AM System 

Server for IBM Notes 
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11 When both install locations are changed, click Next. 

12 In the custom setup wizard, accept the default settings, and then click Next. 

13 Setup copies files to the destination folder; this may take several minutes. 

14 At the Install Wizard Completed dialog box, click Finish. 

Configuring the IBM Notes Client on the MiCollab AM 

System Server 

To set up the IBM Notes Client on the System Server: 

NOTE Configuring the IBM Notes Client on the system server requires a restart of MiCollab AM before 

the IBM Notes Client can be used. 

1 Open MiCollab AM System Configuration, and then select the Main tab. 

2 If the system is running, click Shutdown. Wait until Current Status changes to Stopped.  

3 Close MiCollab AM System Configuration. 

4 Start the IBM Notes client. 

5 At the Welcome dialog box, click Next. 

6 At the User Information dialog box, enter the name of the MiCollab AM user previously registered, 

as indicated in the previous section. 

7 Enter the name of the IBM Domino Server to which you want to connect. 

8 Verify that I want to connect to a Domino Server is selected, and then click Next. 

9 Perform one of the following tasks: 

 If the dialog box, How Do You Want to Connect to a Domino Server displays, continue with 

Step 10. Network issues may be preventing connectivity to the IBM Domino Server named 

previously. 

 If no dialog box appears, skip to Step 14. 

10 Verify that Set up a connection to a local area network (LAN) is selected, and then click Next. 

11 Change the Network Information line to TCP/IP. 

12 In the Server address line, enter the IP address of the IBM Domino Server, and then click Next. 

13 When prompted, enter the password for the voicemail profile user, and then click OK. 

14 Perform one of the following tasks: 

 If you are prompted for the location of your user ID, the client could not find the ID file in the 

Domino Directory. 

Click Browse to locate the ID file to be copied to your local drive, and then click Next. Be sure 

to select Yes to copy the ID file to your local drive. Continue with Step 15. 



Configuring the MiCollab AM System Server for IBM Notes   26 

 If no dialog box displays, skip to Step 16. 

15 At the Additional Services dialog box, click Finish. 

16 Click OK at the Setup Complete dialog box. The IBM Notes Client may take a minute or two to 

open. 

17 When the IBM Notes Client opens, select No thanks, give me the defaults. 

18 Close the IBM Notes Client. 

IMPORTANT To verify network connectivity to the Domino Server, verify that you can ping the 

IBM Domino Server by name. If you cannot, find and correct any network, DNS or 

Host file issues that may be interfering with the test. 

Editing File and Path Statements on the MiCollab AM 

System Server 

IMPORTANT Read this section carefully before beginning this process. It is critical that you enter the 

required information correctly. Any typographical error is likely to prevent E-mail Access 

from functioning properly. When performing the following steps, enter all the characters 

as displayed. 

Windows Server 2012 R2 

To edit the required file and path statements on the MiCollab AM System 

Server: 

1 On the taskbar, select Start, right-click Computer (or This PC), and then select Properties. The 

System Window appears. 

2 Click Advanced System Settings. The System Properties dialog box appears. 

3 Select the Advanced tab. 

4 Click the Environment Variables button. The Environment Variables window appears. 

5 In the System variables table, select the variable, Path, and click the Edit button. The Edit System 

Variable window appears. 

6 In the Variable value field, type the path to the IBM Notes executable. 

For example: 

If Notes is installed at D:\Lotus\Notes, the line should read as follows: 

%SystemRoot%\System32;%SystemRoot%;D:\Lotus\Notes;D:\Lotus\Notes\Data 

7 Click OK to close the Edit System Variable window. 

8 Click OK in the Environment Variables and System Properties windows. 

9 Restart the operating system. 
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10 Log on as domain name\MiCollab AM. 

Windows Server 2016/2019/2022 

To edit the required file and path statements on the MiCollab AM System 

Server: 

1 From the taskbar, select Start > Control Panel. 

2 In the Control Panel, click System and Security > System. 

3 On the left pane, select Advanced System Settings. The System Properties dialog box appears. 

4 Select the Advanced tab. 

5 Click the Environment Variables button. The Environment Variables window appears. 

6 In the System variables table, select the variable, Path, and click the Edit button. The Edit System 

Variable window appears. 

7 In the Variable value field, type the path to the IBM Notes executable. 

For example: 

If Notes is installed at D:\Lotus\Notes, the line should read as follows: 

%SystemRoot%\System32;%SystemRoot%;D:\Lotus\Notes;D:\Lotus\Notes\Data 

8 Click OK to close the Edit System Variable window. 

9 Add a new path for the Data folder of the IBM Notes installation by clicking the New button in the 

System variables table of the Environment variables window. 

For example: 

If Notes is installed at D:\Lotus\Notes, the new path could be:  

D:\Lotus\Notes\Data 

10 Click OK to save the changes to the path variable and close the Edit System Variable window. 

11 Click OK in the Environment Variables and System Properties windows. 

12 Restart the operating system. 

13 Log on as domain name\MiCollab AM. 
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E-mail Access communicates with the IBM Domino Server through a messaging server profile. You 

configure the IBM Domino Server messaging server profile in MiCollab AM Admin, and then assign it to 

Subscriber mailboxes. This prevents configuration problems that might result from mistyped paths in 

individual Subscriber mailboxes. 

Messaging server profiles allow you to control the times of day when Message Waiting Indicator (MWI) 

registration refreshes and the start and stop times for maintenance. 

NOTE During maintenance, the communication between servers is temporarily stopped. 

For proper operation of the Unified Messaging/E-mail Access interface, the MiCollab AM user ID must 

have access to each subscriber’s mail database on that subscriber’s designated home IBM Domino Server 

as defined in the subscriber’s person document of the Name and Address Book. 

The Access Control List (ACL) for each subscriber’s Home Server Mail database must be modified to 

grant the voicemail profile user an access level of Manager – or at least Editor. If the MWI feature is to be 

installed, then Delete documents and Create Personal Agents privileges should be enabled. 

The MiCollab AM user is listed in the format user name/organization.  

See the IBM Domino Server documentation for information about editing the ACL. 

To create a messaging server profile for the IBM Domino Server: 

1 Log on to the MiCollab AM System Server. 

2 Open MiCollab AM System Configuration and select the Main tab. 

3 If the system is running, click Shutdown. Wait until Current Status changes to Stopped.  

4 Start the MiCollab AM Admin utility and log on using your administrator’s name and password. 

5 From the menu bar, select Configuration > System, and then select the E-mail tab. 

6 Click Add. The Server Profile dialog box appears. 

7 From the Server Type dropdown list, select Notes. 

8 Select the Supports External Mail Store checkbox. 

9 In the Display Name box, type a unique name, 30 characters or less, for the Messaging Server 

profile. 

Creating Messaging Server Profiles to 

Communicate with the IBM Domino 

Server 
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10 In the Domain box, enter the fully qualified domain name (FQDN) of the Windows domain of which 

the E-mail or messaging server is a member. 

11 In the Route/Path box, type the common name of the IBM Domino Server to which MiCollab AM is 

connecting.  

For example: 

If the hierarchical name of the server were CN=DominoSvr2/O=MyOrg, you would type 

DominoSvr2 here. Consult your LAN or Notes/Domino administrator or the Server document in 

the Name and Address book, for additional assistance and information.  

12 In the Logon ID box, enter the logon ID of the voicemail profile user. 

13 In the Password box, type the password of the voicemail profile user. 

14 In the Confirm Password box, confirm the password you specified in the previous step. 

15 Click Verify. E-mail Access validates access to an LDAP directory on the IBM Domino Server. 

IMPORTANT In IBM Notes/Domino installations, the Verify button tests only the ability of 

MiCollab AM to gain access to an IBM Notes Server. LDAP is not required with 

Unified Messaging for IBM Notes and Domino. 

NOTE In a call to LDAP, the / character is a delimiter. Therefore, if the IBM Domino Server cannot 

be contacted by the server name alone and instead requires the fully distinguished 

reference server name/organization name, the LDAP features of MiCollab AM cannot be 

used. 

16 Configure the messaging server profile to stop external store access during IBM Domino Server 

maintenance as follows: 

 If you want to stop E-mail Access during IBM Domino Server maintenance, continue with Steps 

16a-16c. 

 If you do not want to stop E-mail Access during IBM Domino Server maintenance, skip to Step 

17. 

a Under Maintenance, select the Enabled box. 

b In the Start box, select a time to disable the messaging server profile so that maintenance of 

the IBM Domino Server can begin. 

c In the Stop box, select a time to re-enable the messaging server profile when maintenance of 

the IBM Domino Server is complete. 

17 Select the Enabled check box to enable the messaging server profile. 

18 Click OK to close the Server Profile dialog box. 
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19 In the E-Mail tab, click Apply to save the changes.  

20 To verify the setting of the messaging server profile, select server name you just added, and then 

click Edit. 

21 Click OK to close the Server Profile dialog box. 

22 In MiCollab AM System Configuration, select the Main tab. 

23 Click Startup. 

24 Wait until Current Status displays Running, and then click OK to close MiCollab AM System 

Configuration. 

NOTE Refer to Appendix C: Administering MiCollab AM When Using the IBM Domino Server 

Interface for critical concerns related to MiCollab AM Admin. 
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For proper operation of the IBM Notes interface in a subscriber mailbox, the voicemail profile user must 

have access to each subscriber’s mail database on the designated home IBM Domino Server, as defined in 

the user’s person document of the Name and Address book. 

The Access Control List (ACL) for each subscriber’s Home Server Mail database must be modified to 

grant the voicemail profile user an access level of Manager – or at least Editor. If the MWI feature is to be 

installed, then Delete documents and Create Personal Agents privileges should be enabled.  

The MiCollab AM user is listed in the format user name/organization.  

IMPORTANT On a cluster of IBM Domino Servers, all replicas must have the same access levels and 

privileges set in the ACL for voicemail profile user created in Creating the Voicemail Profile 

User on the IBM Domino Server.  

See the IBM Domino Server documentation for information about modifying the ACL. 

IMPORTANT The IBM Notes Client must not be running on the MiCollab AM System Server while the 

MiCollab AM Service is running. 

The following steps must be performed on each Subscriber mailbox that uses Unified Messaging. 

To configure Subscriber mailboxes for use with Unified Messaging: 

1 Verify that MiCollab AM is running. 

a Log on to the MiCollab AM System Server using the MiCollab AM Service account. 

b Open MiCollab AM System Configuration. 

c Select the Main tab, and verify that MiCollab AM is Running, or click Startup to start MiCollab 

AM. 

2 Log on to MiCollab AM Admin. 

3 Locate and open the Subscriber mailbox you wish to work on. 

4 On the Subscriber Mailbox, select the E-Mail tab. 

5 In the Server Profile dropdown list, select the messaging server profile created in the previous 

procedure. 

6 Under Message Access by Client Applications, select Unified Messaging. The Message Storage 

Location is set to External automatically. Choosing this option counts towards the available UM 

licenses. 

Configuring a Subscriber for Unified 

Messaging 



Configuring a Subscriber for Unified Messaging   32 

NOTE The Enable profile box is selected automatically for this profile. 

Proceed as follows: 

 If you are not using LDAP, continue with Step 7. 

 If you are using LDAP, skip to Step 8. 

7 Configure the Display Name and E-Mail Address boxes. 

IMPORTANT The Display Name and E-Mail Address boxes must be filled in. If either box is left 

blank, the profile will not register properly. 

NOTES 

1. In the Display Name box, type the subscriber’s fully distinguished name as defined in the 

Name and Address book. 

2. This name must be unique for each subscriber. 

3. The IBM Domino Server administrator should be able to provide this information based on the 

User name, Alternate name, or Short name fields on the Person document in the Name 

and Address book.      

8 Under the E-mail server information section, in the E-Mail Address box, type the subscriber’s 

email address. 

9 Under the E-mail server information section, click Search. The Subscriber Mailbox E-mail 

Search dialog box appears. 

10 Select the Search Type and type Search String that matches the search type you selected, and 

then click the Search button. 

NOTE The Search is conducted using LDAP and is dependent upon proper LDAP configuration. 

You may need to change the user’s name to how it appears in the User name, Alternate 

name, or Short name fields in the Name and Address book. 

  LDAP does not allow use of a hierarchical name, /, , and other non-alphabetic characters, 

which may cause an LDAP search to fail. 

11 In the Search Results list, select the E-mail account, and then click OK. 

12 The Display Name and E-Mail Address boxes are filled with the information obtained from the 

search. 

13 Verify that the E-mail checkbox in the Msg Access by Telephone section is selected (per the 

procedure described in Enabling E-mail Access Globally). If the E-mail checkbox is not selected, 

then select the E-mail checkbox to enable TUI access for E-mail messages. 

14 Click OK to save and close the Subscriber mailbox. 

15 Repeat Steps 3 through 14 for each subscriber you want to enable for Unified Messaging for Lotus 

Notes. 
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NOTE If the optional MiCollab AM Media player (installed on the subscriber’s Windows workstation) will 

be deployed, the MiCollab AM server administrator must enable lines on the Lines tab so the 

MiCollab AM System can make callouts. This type of callout allows subscribers to use a telephone 

to listen to messages when using the optional MiCollab AM Media Player.   

  In addition, the MiCollab AM server administrator must verify that the values are appropriate for 

the Incoming Line Reserve and Maximum Callouts settings on the Switch Section Options 

dialog box from the Switch Sections tab.  
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This document contains two general methods for installing MiCollab AM Unified Messaging mail 

templates on the IBM Domino Server as follows. Choose the method that best fits your environment. 

 The first method uses a very basic IBM Notes/Domino system using the default Mail template. 

 The second method uses a modified or custom mail template.  

IMPORTANT A certified Notes/Domino administrator or a Notes developer who is proficient in template 

design should perform the following procedures. 

NOTE If your environment differs greatly from the methods listed or your IBM Domino Server is not 

running on a Microsoft Windows operating system, please contact Mitel Technical Support to 

discuss installation options specific to your environment. 

Table 3. Main installation methods 

If your default mail template… Then… 

Has not been customized   Install the MiCollab AM Unified Messaging mail template on 

the Domino Server. Refer to Installing the MiCollab AM Default 

Mail Template on the IBM Domino Server. 

 Update the user’s mail files to use the Unified Messaging 

templates. Refer to Upgrading a User’s Mail Files to Use 

Unified Messaging Templates on the IBM Domino Server. 

Has been customized   Refer to Appendix B: Installing MiCollab AM into a Customized 

IBM Notes Mail Template. 

Installing the MiCollab AM Default Mail Template on 

the IBM Domino Server 

This section covers the tasks required to install the MiCollab AM Unified Messaging template prior to the 

default mail template customization.  

IMPORTANT This task loads the mail template for MiCollab AM Unified Messaging needed by the IBM 

Domino Server for Web-based access. The IBM Notes/Domino administrator must 

perform this task.  

Installing MiCollab AM Mail Templates 

on the IBM Domino Server 
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When you install the MiCollab AM Unified Messaging mail template to the IBM Domino data directory, 

the installation signs it with the Notes/Domino ID of the user that does the installation automatically. If 

this is not your template signing authority, you need to re-sign the template manually with that ID. This 

action ensures that this template contains the same signature contained in the user’s Execution Control 

List (ECL). Otherwise, the user is prompted to cross-certify this database signature. 

NOTE For more information about the ECL and signing a database, see the IBM Notes Administration 

online Help.  

This installation allows you to install any or all of the following items on the IBM Domino Server: 

 MiCollab AM Unified Messaging Mail template 

 Message Waiting Indicator (MWI) for Notes application for IBM Domino Server 

IMPORTANT Perform these procedures at the IBM Notes administrator’s workstation. The 

administrator’s user ID must have the ability to Run unrestricted IBM Script/Java 

agents and Create new databases on the Mail server. Check these settings before 

proceeding.  

To install the templates and/or applications: 

1 Insert the MiCollab AM Installation Media into the workstation’s appropriate drive. 

2 Copy the installation database, CXInstall.nsf from the drive where the installation media is inserted 

to the …\Notes\Data folder on the workstation’s disk drive. 

 If you are installing the U.S. edition: 

Copy the database from the …\Client Installs\Desktop Suite for Domino\Templates\Install\ 

USA folder on the installation media. 

 If you are installing the World edition: 

Copy the database from the …\Client Installs\Desktop Suite for Domino\Templates\Install\ 

World folder on the installation media. 

3 From the Windows taskbar, select (or right-click) Start, and then select Run. The Run window 

appears. 

4 In the Open textbox, specify the full path and filename of the installation database you copied to 

the workstation in Step 2.  

5 Click OK to continue. 

NOTE When prompted to cross-certify Domino Template Designer\Mitel, click Trust Signer. This 

cross-certification can be removed from the ECL later, if desired. 

6 At the MiCollab AM dialog box, click Next. 

7 From the dropdown list, select the server on which you would like to install the templates and/or 

add-ins. 

8 When prompted, click Start trusting the signer to execute this action. 
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9 Click Mail Templates. 

NOTE Voice messages in Notes display as regular E-mail messages with a .wav file attached where 

you can use the default media player to play the message. The custom player only operates 

with the regular Notes (thick) client. 

10 Select the appropriate version and language of the mail template for your IBM Domino Server. 

11 Select one of the following options: 

Table 4. Template Versions 

If you are using mail template version... Then select... 

R8.5 (English) – CXmail85.ntf 

R9.0 (English) – CXmail90.ntf 

12 Proceed according to whether or not you are installing the Message Waiting Indicator (MWI) for 

Notes application. 

 If you are installing the MWI for Notes application, keep this installer open and follow the steps 

in the next section, Installing MWI for Notes on the IBM Domino Server. 

 If you are not installing the MWI for Notes application, click Finish. 
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To install the MWI for Notes application on the IBM Domino Server, you must install the MWNDB.nsf file. 

This procedure begins on the previous page in step 11. 

NOTE The MWI feature is available only if the IBM Domino Server is running on Windows Server 2012 

R2, Windows Server 2016 (Server with Desktop Experience), Windows Server 2019 (Server with 

Desktop Experience), or Windows Server 2022 (Server with Desktop Experience). 

To install MWI for Notes: 

1 Open the location where the installation media is inserted, and double-click the start.hta file. The 

MiCollab AM installation page appears. 

2 In the Server Components menu area, select MWI for Notes (32-bit) or MWI for Notes (64-bit). 

WARNING Be sure to select the component matching the IBM Domino Server installation. 

Selecting the wrong component can lead to installation failure. If the IBM Domino 

server was installed as 64-bit, then select MWI for Notes (64-bit) 

3 In the Welcome page, click Next. The License Agreement dialog box appears. 

4 Click Yes to accept the License Agreement.  

The Start Copying Files window appears and displays the path where the file will be installed. The 

path is not editable.  

 

Installing MWI for Notes on the IBM 

Domino Server 
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5 Click Next to start copying the program files. The Mitel MiCollab AM MWI for Lotus Notes 

Configuration dialog box appears after the files are copied. 

6 In the Port field of the Mitel MiCollab AM MWI for Lotus Notes Configuration dialog box, type 

the port number on which the MiCollab AM System Server listens. The value provided here should 

match the value entered in TCP/IP Port control on the E-mail tab of the MiCollab AM 

Configuration utility. 

 

 

NOTE The controls on the E-mail tab are only available for systems that are not hosted on the 

cloud. If the system is hosted on the cloud, this control is grayed out and Unified Messaging 

for Lotus Notes and Domino is unavailable.  
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7 In the Address field of the Mitel MiCollab AM MWI for Lotus Notes Configuration dialog box, 

type the name of the MiCollab AM System Server. Verify the name by pinging the MiCollab AM 

System Server from the IBM Domino Server by name. 

 

8 Click Next, and then click Finish. 

9 On the “Unified Messaging – Notes Installer” page still open from the previous procedure (Installing 

the MiCollab AM Default Mail Template on the IBM Domino Server), expand the MWI Add-in 

section. 

10 Select the (English) – MWNDB.nsf checkbox, and then click Install. A progress bar indicates that 

the files are being copied to the server. 

IMPORTANT This procedure is dependent on several factors and may take a long time to run. If 

the length of time to complete the procedure seems excessive, or if an error occurs 

during the procedure, contact Mitel Technical Support. 

  When the installation completes, the IBM Notes Client displays an install log. If the 

log reports any unsuccessful items, contact Mitel Technical Support for instructions 

on how to proceed. 

11 In addition to the Notes extension, there is a Windows Service installed. The Service must be 

running for notifications to be sent to the MiCollab AM System Server. Open the Services console, 

and then start the MWI for Notes Service. 

12 Debug logging can be enabled or disabled by modifying the notesmwn.ini file in the Domino 

directory. 

 A value of 1 enables logging; and a value of 0 disables logging. 

 The extension is set by the extension_debug entry and the server is set by the server_debug 

entry.  

 With debug logging enabled, log files are created in a folder called MitelLogs located in the 

Domino directory. 
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 The extension_console_debug logging entry controls MWI debug information that goes to 

the Domino console. This is disabled by default and enabling it for Domino R8.5 has known 

stability issues. 

13 Restart the IBM Domino Server. As the IBM Domino Server restarts, notice in the console window, 

debug logs, or in the file notes.log that there are several references to NotesMWNExtension 

related with each Domino process at it starts. 

These references indicate that MWI for Notes application installed successfully. 
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After installation is complete, either the new Unified Messaging template or an updated, customized mail 

template is ready to be deployed. This procedure can be completed one mail file at a time or in bulk using 

the mail conversion utility. 

Upgrade mail files at a time when your subscribers are not accessing them; for example, early in the 

morning or over a weekend. It is recommended that you notify users that their mail files will be 

unavailable during this time. 

WARNING The mail conversion utility discussed in the following procedure can destroy important 

information if it is misused. 

 The command-line syntax given for the utility is based on Notes and Domino defaults, but it 

may not be appropriate to your system. 

 Before you proceed, review the layout of your system, and consult the Notes 

administrative help. If you have any questions about the use of the mail conversion utility, 

contact Mitel Technical Support. 

To upgrade user’s mail files: 

1 Type, tell router quit, and then press -Enter-.  

NOTE The Domino Server cannot route mail to the mail files while they are being upgraded. Mail 

is stored in MAIL.BOX while you upgrade the mail files. Once the mail files are upgraded, 

and the router task is restarted, the router processes and delivers the mail in MAIL.BOX.  

2 Load the mail conversion utility by typing one of the following: 

Table 5. Mail Template Versions 

If you are using mail template version... Then type... 

R8.5 load convert -r mail\*.nsf * CXmail85.ntf 

9.0 load convert -r mail\*.nsf * CXmail90.ntf 

IMPORTANT Your syntax may differ slightly, and incorrect syntax may interfere with the proper 

operation of your system. Consult the IBM Administration online help for more 

information when using the Load Convert command. 

Upgrading a User’s Mail Files to Use 

Unified Messaging Templates on the IBM 

Domino Server 
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3 Press -Enter-. The above command line finds all databases located in the \MAIL subdirectory of the 

Notes data directory and all subdirectories of the \MAIL directory. 

For example: 

C:\NOTES\DATA\MAIL\GROUP1, C:\NOTES\DATA\MAIL\GROUP2, and 

C:\NOTES\DATA\MAIL\GROUP3) and upgrades them to the R8.5 or R9 MiCollab AM Unified 

Messaging mail template.  

4 When you have finished upgrading mail files to the Unified Messaging template on this server, 

reload the router by typing, load router, and then press Enter. 
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The MiCollab AM Unified Messaging MWI setup program adds or modifies the following files on the IBM 

Domino Server: 

 Adds a NotesMWN.ini file, which contains MWI for Notes configuration information to the path 

that contains the Domino executable files (typically C:\Notes\Domino). 

 Adds AT_NotesMWNExtension.dll, AT_NotesMWNServer.exe, and Tracy.dll files to the path that 

contains the Domino executable files. 

 Modifies the existing Notes.ini file with the following line:  

EXTMGR_ADDINS=NotesMWNExtension.dll 

NOTE This line is case sensitive. 

 Adds an MWNDB.NSF database file in the Data directory. 

 Adds a folder for debug logs named MitelLogs to the path that contains the Domino executable 

files. 

After the MWI feature is installed on the IBM Domino Server, you have started the MWI for Notes Service, 

and restarted the IBM Domino Server, you can activate the feature on MiCollab AM for each Subscriber 

mailbox using Notes. 

To activate the MWI feature for each subscriber: 

1 Log on to the MiCollab AM System Server with the Windows Server domain name for MiCollab AM 

account. 

2 Log on to MiCollab AM Admin. 

3 Locate and open the Subscriber mailbox you wish to work on. 

4 On the Main tab, select the Set MWI checkbox. 

5 Click OK to save and close the Subscriber mailbox. 

6 Repeat Steps 3 through 5 for each subscriber for whom you want to activate MWI. 

Activating the Message Waiting 

Indicator Feature 
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To integrate MiCollab AM Unified Messaging with a third-party fax server such as Esker Fax, Fenestrae 

Faxination, or Interstar XMediusFAX, you need the following information: 

 The name of the foreign domain defined to support sending and receiving of fax messages on the 

IBM Domino Server. 

 The filename extension that the fax server uses for the fax image files it attaches to E-mail messages, 

if you want to exclude other attachment extensions for security reasons. 

The fax foreign domain is created during installation of the fax server. Within Domino Administrator, you 

can view and change the configuration of this domain on the Configuration tab through the tree menu, 

Messaging > Domain > Foreign Domain. 

Additional information on the foreign domain name and filename extensions the fax server uses is also 

normally available in the documentation that accompanies the fax server software. 

To integrate MiCollab AM Unified Messaging with a third party fax server: 

NOTE Integrating MiCollab AM Unified Messaging with a third party fax server requires MiCollab AM to 

be shut down and then restarted. 

1 Open MiCollab AM Configuration and select the Main tab. 

2 If the system is running, click Shutdown. Wait until Current Status changes to Stopped.  

3 Select the Fax tab.  

4 Select Third Party as the Fax Type, and then click OK. 

5 Open MiCollab AM Admin, select Configuration > System, and then select the Fax tab. 

6 Select Third Party for the Fax Type, and then click OK. 

7 Select Notes as the Message Store Type. 

8 Type the Fax Domain Name and the Fax Template String. 

9 In the Message Classes box, click Add New, and then type a new message class name used for fax 

messages on the IBM Domino Server (for example, NOTES.FAX).  

10 Click OK to add the class name to the Message Classes list. 

11 Repeat Steps 9 to 10 to add any additional class names that are needed. 

12 Proceed according to whether or not you want to restrict the filename extensions that are 

acceptable for fax attachment files. 

Integrating with a Third Party Fax Server 

(Optional) 
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Table 6. Restriction Procedures for Fax Attachment 

If you want to… Then… And… 

Restrict fax attachments to one or more 

specific filename extensions 

Clear Allow All Continue with Step 13. 

Allow all filename extensions for fax 

attachments 

Leave Allow All 

selected 

Skip to Step 17. 

13 In the Allowed File Extensions group, click Add New.  

14 In the File Extension box, type a file extension (for example, .tif) that MiCollab AM allows 

subscribers to receive as fax messages.  

15 Click OK to add the extension to the list of allowed extensions. 

16 Repeat Steps 12 to 15 to add any additional extensions that MiCollab AM should allow. 

17 Open MiCollab AM Configuration, select the Main tab, and then click Startup. 
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After the templates are installed on the IBM Domino Server and the user’s mail files have been upgraded, 

each workstation accessing the templates must have the MiCollab AM Unified Messaging client software 

installed. 

Installation of this client software creates the Unified Messaging Connection Manager utility in the 

MiCollab AM Desktop program group, updates the voice-messaging menu and toolbar buttons, and 

places an online help file in the MiCollab AM Desktop program group. 

Before you can configure the MiCollab AM Unified Messaging client on subscriber workstations, ensure 

the following tasks are complete: 

 MiCollab AM and IBM Domino Server are attached to the same LAN 

 A Subscriber mailbox is created on MiCollab AM for the user 

 The subscriber has access to an external message store account on the IBM Domino Server 

 An IBM Notes Client installed on the subscriber workstation 

 Telephone access to and from the MiCollab AM system to support audio recording, audio playback, 

and Live Reply 

Subscribers must configure their connections to MiCollab AM with the Unified Messaging Connection 

Manager utility before they can access MiCollab AM to generate voice messages, and retrieve voice and 

fax messages in Notes. 

For specific information on using Unified Messaging Connection Manager, see the MiCollab AM Unified 

Messaging client online help. 

The following three methods are available for installing the client on subscriber desktops: 

 The push method installs the client software on one or more workstations at the initiation of an 

administrator, through command-line prompts or third-party deployment software. Workstations 

must be logged on to the network but no subscriber presence or action is required. 

 The pull method distributes a link to one or more workstations so that the subscriber can initiate an 

installation of client software from a network source. This is performed from a command line or 

through third party deployment software. The administrator needs only to create a default 

subscriber profile before distributing the link. 

 The direct method involves installing the client software from the MiCollab AM Installation Media at 

each subscriber workstation. This method is useful for the addition of single subscribers or for 

remote subscribers who do not have LAN or Internet connections. 

Installing MiCollab AM Client Software 

on Subscriber Workstations for Notes 
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Administrative Setup of the MiCollab AM Unified 

Messaging Client on a LAN File Server 

IMPORTANT If you plan to install the MiCollab AM Unified Messaging client using the push or pull 

methods, the client software must first be installed to a LAN file server prior to setting up 

each workstation. 

Setting up the MiCollab AM Unified Messaging client software on a LAN file server requires an 

Administration Setup. Performing an Administration Setup copies the necessary software components of 

the MiCollab AM Installation Media to a shared directory on the LAN file server and creates a default 

subscriber profile. 

This client and profile can be pushed to client workstations, or subscribers can pull from this shared 

location, and run Setup to install the MiCollab AM Unified Messaging client to their local hard disk drives.  

IMPORTANT Do not perform an Administration Setup on a MiCollab AM System Server. Using a 

MiCollab AM System Server as a LAN file server can increase its vulnerability to viruses 

and negatively affect overall system performance. 

To perform an Administrative Setup of Unified Messaging client software on 

a LAN file server: 

1 Log on to the file server where the client setup file is to be installed. 

2 Insert the MiCollab AM Installation Media into the appropriate drive of the file server. 

3 Depending on which edition you wish to install, type or browse to one of the following command 

lines using the Command Prompt or Run tools. 

 If you are installing the U.S. edition, type: 

 <drive>:\Client Installs\Desktop Suite for Domino\SBUM Client\USA\Setup.exe -a _ENTER_ 

 Skip to Step 5. 

 If you are installing the World edition, type: 

 <drive>:\Client Installs\Desktop Suite for Domino \SBUM Client\World\Setup.exe -a _ENTER_ 

 Continue on to Step 4.  

NOTE Replace <drive> with the drive letter appropriate for your installation. 

4 From the list box within the Choose Setup Language dialog box, select the language you want to 

use during the setup process, and then click OK to continue. 

NOTE The language selection in this step affects only the setup program itself. The setup program 

copies support files for all available languages to the file server. 

5 At the Welcome dialog box, click Next. 
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6 The Administrator Install dialog box appears. The properties set in this dialog box are used as 

defaults for client installations. 

 

7 In the Administrator Install dialog box, configure the following options: 

 In the Server Name field, enter the name of the MiCollab AM System Server. 

 In the Protocol field, select either the TCP/IP or Named Pipes protocol. 

 In the Playback Settings and Record Settings fields, select the default playback and record 

settings. Telephone is the default selection. 

 In the Record Message File Encoding and the Record Non-Message File Encoding fields, 

select the file encoding format for client workstations. OKI ADPCM is the default value. 

NOTE The client encoding settings can be set differently than those of the server. However, 

the client settings are overwritten when connection to the MiCollab AM System Server 

is established. 

 In the Auto Play Messages in Email Client field, select an option. None is the default value. 

 In the Install Path on Client Machine field, enter the path or leave the default path as is. Make 

note of this path, you need it later in this procedure. 

 Select the Overwrite existing personal settings checkbox, if any existing client defaults 

should be changed to the new defaults. 

 Select the Install OKI Drivers during silent installs checkbox if the client workstations are 

using the OKI ADPCM encoding. 

8 Click Next. The confirmation message displays stating the admin parameters have been saved. 

9 Click OK. 



Installing MiCollab AM Client Software on Subscriber Workstations for Notes   49 

Installing the MiCollab AM Unified Messaging Client 

Software on a Workstation 

NOTE If you are installing the client software on a Citrix® MetaFrame® server and the MiCollab AM 

System Server uses OKI ADPCM audio format for voice messages, you must install the MiCollab 

AM OKI ADPCM driver on the MetaFrame server. The setup program for the OKI ADPCM driver is 

located in the …\Client Installs\Desktop Suite for Domino\ACM directory on the MiCollab AM 

Installation Media. 

 If you want to install the client software onto a computer running a Windows Server operating 

system, log on to the computer with an account that has local administrator rights to the 

workstation so that all necessary program components, especially the audio compressor/de-

compressor, are installed correctly. 

To install the client software on a workstation from the Installation Media: 

1 Insert the MiCollab AM Installation Media into the appropriate drive. 

2 When the Mitel MiCollab AM Installation Components dialog box displays, click the appropriate 

link as follows: 

 If you are installing the U.S. edition, click Desktop Suite for Domino (USA).  

 If you are installing the international edition, click Desktop Suite for Domino (World). 

NOTE If the Mitel MiCollab AM Installation Media Components dialog box does not display, 

navigate to the …\Client Installs\Desktop Suite for Domino\SBUM Client folder on the 

media. Then, depending on the edition of the software you want to install, navigate to 

either the USA folder or the World folder, and then double-click the Setup.exe file. 

3 If the Choose Setup Language dialog box appears, select the language you want to use during the 

setup process, and then click OK to continue. 

NOTE The language selection in this step affects only the setup program itself. The setup program 

copies support files for all available languages to the file server. 

4 The Welcome dialog box appears. Verify that no other programs are running, and then click Next. 

5 In the Destination Folder section of the Choose Destination Location dialog box, accept the 

default destination directory, type the path of another destination directory, or click Browse to 

locate another destination directory. 

6 The Question dialog box appears. 
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In the Question dialog box: 

 Click Yes to access and configure the Unified Messaging Connection Manager utility 

immediately. Go to next Step 7. 

 Click No if you want to configure the Unified Messaging Connection Manager utility later. 

Skip to Step 8. 

NOTE You cannot use MiCollab AM Unified Messaging until you configure the settings in 

the Unified Messaging Connection Manager utility. For more information on 

configuring the utility, refer to Configuring MiCollab AM Unified Messaging Settings. 

7 If you clicked Yes, the Telephony Server Login dialog box displays that will allow you to log in to 

the Unified Messaging Connection Manager utility. 

 

In the Telephony Server Login dialog box: 

a Enter the Server address, Username, and Security Code, and then click OK. 

NOTE For a single tenant system, you can use either the MailboxID or the Username for the 

Telephony Server Login.  

Or click Work Offline if you want to configure the Unified Messaging Connection Manager 

utility locally without getting connected to the server. 

b When the Unified Messaging Connection Manager utility displays, configure the options as 

described in the Configuring MiCollab AM Unified Messaging Settings section. 

c When finished configuring, click OK. 

8 The InstallSheild Wizard Complete dialog box displays prompting to restart your computer. 

Select the following: 

 Select Yes and click Finish to restart your computer now. 

 Select No and click Finish to restart your computer later. 

9 When the installation completes, the Unified Messaging Connection Manager is added to the 

MiCollab AM Desktop program group. 
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To install the client software on a workstation from a network file server: 

1 Locate the appropriate setup folder on the network file server. (The location of this file was 

established during implementation and then communicated to the subscriber base.) 

NOTE A shortcut (.lnk file) to the setup file may appear on the subscriber desktop or be included 

in E-mail or web communication. 

2 Double-click Setup to begin the setup process. 

3 If the Choose Setup Language dialog box appears, select the language you want to use during the 

setup process, and then click OK to continue. 

NOTE The language selection in this step affects only the setup program itself. The setup program 

copies support files for all available languages to the file server. 

4 The Welcome dialog box appears. Verify that no other programs are running, and then click Next. 

5 In the Destination Folder section of the Choose Destination Location dialog box, accept the 

default destination directory, type the path of another destination directory, or click Browse to 

locate another destination directory. 

6 The Question dialog box appears. 

 

In the Question dialog box: 

 Click Yes to access and configure the Unified Messaging Connection Manager utility 

immediately. Go to Step 7. 

 Click No if you want to configure the Unified Messaging Connection Manager utility later. 

Skip to Step 8. 

NOTE You cannot use MiCollab AM Unified Messaging until you configure the settings in 

the Unified Messaging Connection Manager utility. For more information on 

configuring the utility, refer to Configuring MiCollab AM Unified Messaging Settings. 

7 If you clicked Yes, the Telephony Server Login dialog box displays that will allow you to log in to 

the Unified Messaging Connection Manager utility. 
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In the Telephony Server Login dialog box: 

a Enter the FQDN or the TCP/IP address of the MiCollab AM System Server in the Server box, 

subscriber Username, and Security Code. 

NOTE If you are using TCP/IP as the connection protocol, use the TCP/IP address of the 

MiCollab AM System Server. Contact your MiCollab AM or LAN administrator for this 

IP address, if necessary. Using an IP address in the Server Name box can avoid 

possible DNS or name resolution issues on a LAN. 

Or click Work Offline if you want to configure the Unified Messaging Connection Manager 

utility locally without getting connected to the server. 

b When the Unified Messaging Connection Manager utility displays, configure the options as 

described in the Configuring MiCollab AM Unified Messaging Settings. 

c When finished configuring, click OK. 

8 The InstallShield Wizard Complete dialog box displays prompting to restart your computer. 

Select the following: 

 Select Yes and click Finish to restart your computer now. 

 Select No and click Finish to restart your computer later. 

9 When the installation completes, the Unified Messaging Connection Manager is added to the 

MiCollab AM Desktop program group. 

Configuring MiCollab AM Unified Messaging Client 

Settings 

You must configure several settings prior to a subscriber’s first use of the MiCollab AM Unified Messaging 

client. Subscribers who are familiar with the necessary settings can perform this procedure themselves; for 

those subscribers who are not familiar with the settings, MIS support staff should perform the procedure. 

To configure the MiCollab AM Unified Messaging client: 

1 From the taskbar, go to the Start > All Programs (or Apps) > MiCollab AM Desktop > Unified 

Messaging Connection Manager. 

2 The Telephony Server Login dialog box appears. 
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In the Telephony Server Login dialog box: 

 Enter the FQDN or the TCP/IP address of the MiCollab AM System Server in the Server box, 

subscriber Username, and Security Code. 

 Or click Work Offline if you want to configure the Unified Messaging Connection Manager 

utility locally without getting connected to the server. 

NOTE If you are using TCP/IP as the connection protocol, use the TCP/IP address of the MiCollab 

AM System Server. Contact your MiCollab AM or LAN administrator for this IP address, if 

necessary. Using an IP address in the Server Name box can avoid possible DNS or name 

resolution issues on a LAN. 

3 Click OK. The Unified Messaging Connection Manager dialog box appears. 

   

NOTE If you clicked Work Offline, the Security Code tab will not appear. 

4 In the Unified Messaging Connection Manager dialog box, configure the following properties: 

 Record and Playback Tab 

 In Playback Settings and Record Settings fields, select the default device for playback 

and recording. The default selection is Telephone. 
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 Click the Advanced button and adjust the sound quality of the voice message. The 

available options are 6.0 kHz (Default), 8.0 kHz, or 11.025 kHz. 

 

 In the Phone Extension box, type the subscriber’s telephone extension that will be used 

for playback and recording of messages. 

 Click the Server Settings button if you want to change any server options. Update the 

values and click OK to close the Server Settings dialog box. 

 

 Security Code Tab 

 If you want to change your security code at this time, in the Change Telephony Server 

Security Code field, enter a new security code and re-enter the security code. Click Save. 

5 Click OK to close the Unified Messaging Connection Manager dialog box.  
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Windows 8.1 (or later) does not allow the installer to define XMediusFAX Viewer as the default application 

for Tagged Image File Format (TIFF or TIF) files. You must set this manually, if you want to have faxes 

automatically displayed in XMediusFAX Viewer.  

To set the default viewer for TIFF files: 

1 From the Windows taskbar, go to Start > Control Panel > Programs > Default Programs > 

Associate a file type or protocol with a program. The Set Associations window appears. 

2 In the Extensions table, scroll down until you find .tif, and then select the extension. 

3 Click the Change program button. The How do you want to open this type of file (.tif)? dialog 

box displays with the list of apps. 

4 On the dialog box: 

 If you see Viewer.exe XMedius Solutions Inc. on the list, select the app. Skip to Step 5. 

 If you don’t see Viewer.exe XMedius Solutions Inc. as an option on the list: 

a Select More options. The apps list expands. 

b If Viewer.exe XMedius Solutions Inc. appears in the expanded list, select the option. 

Skip to Step 5. 

c Otherwise, scroll down to the bottom of the list and select Look for another app on this 

PC. The Open with window appears. 

d Browse to C:\Program Files\XMediusFAX\Client\. 

NOTE Depending on where Unified Messaging Client was installed and the Operating 

System, the XMediusFAX directory may be under Program Files (x86). 

e Select Viewer.exe and click Open.  

5 You are returned to the Set Associations window. Make sure Viewer.exe is set as the Current 

Default app for the .tif extension. 

6 Follow the same procedure for .tiff. 

 

Setting XMediusFAX Viewer as Default in 

Windows 8.1 (or later) 
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The following section provides steps to enable subscribers to get up and running quickly. Distribute the 

information on these pages as necessary. 

Getting Help for MiCollab AM Unified Messaging for 

IBM Notes 

For information on working with voice and fax messaging within IBM Notes, see the online help. 

 To access online help 

From the taskbar, go to Start > Programs > MiCollab AM Desktop > UM for IBM Notes Help. 

 To print any help topic 

Click the Print button at the top of the window. The current topic prints on your default printer. 

 To print multiple help topics in a book 

Select the book on the Contents tab of the Help topics window, and then click the Print button. 

All the topics within that book are printed. You may want to open the book to see how many topics 

are selected. Some books contain a large number of topics. 

Configuring MiCollab AM Unified Messaging Settings 

You may want to modify the settings for your Subscriber mailbox from time to time. 

For example: 

You may decide to switch the playback device from your telephone to your computer ’s sound card and 

speakers. 

You can modify these options in Unified Messaging Connection Manager, Web PhoneManager, or 

from your mobile application.  

To configure MiCollab AM Unified Messaging Settings from Unified 

Messaging Connection Manager: 

1 From the taskbar, go to Start > Programs > MiCollab AM Desktop > Unified Messaging 

Connection Manager. 

2 The Telephony Server Login dialog box appears. 

In the Telephony Server Login dialog box: 
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 Enter the FQDN or the TCP/IP address of the MiCollab AM System Server in the Server box, 

subscriber Username, and Security Code. 

 Or click Work Offline if you want to configure the Unified Messaging Connection Manager 

utility locally without getting connected to the server. 

NOTE If you are using TCP/IP as the connection protocol, use the TCP/IP address of the MiCollab 

AM System Server. Contact your MiCollab AM or LAN administrator for this IP address, if 

necessary. Using an IP address in the Server box can avoid possible DNS or name 

resolution issues on a LAN. 

3 Click OK. The Unified Messaging Connection Manager dialog box appears. 

   

NOTE If you clicked Work Offline, the Security Code tab will not appear. 

4 In the Unified Messaging Connection Manager dialog box, configure the following properties: 

 Record and Playback Tab 

 In Playback Settings and Record Settings fields, select the default device for playback 

and recording. The default selection is Telephone. 

 Click the Advanced button and adjust the sound quality of the voice message. The 

available options are 6.0 kHz (Default), 8.0 kHz, or 11.025 kHz. 

 In the Phone Extension box, type the subscriber’s telephone extension that will be used 

for playback and recording of messages. 

 Click the Server Settings button if you want to change any server options. Update the 

values and click OK to close the Server Settings dialog box. 

 Security Code Tab 
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 If you want to change your security code at this time, in the Change Telephony Server 

Security Code field, enter a new security code and re-enter the security code. Click Save. 

5 Click OK to close the Unified Messaging Connection Manager dialog box.  

Changing Your Mailbox Security Code 

You can change your mailbox security code from the Security Code tab. 

To change your mailbox security code: 

1 From the taskbar, go to Start > Programs > MiCollab AM Desktop, and then click Unified 

Messaging Connection Manager. 

2 In the Telephony Server Login dialog box, enter Server Name, Username, and Security Code, 

and then click OK. 

3 Click the Security Code tab. 

IMPORTANT If you clicked Work Offline in Step 2, the Security Code tab won’t be available. 

4 In the New Security Code and Confirm Security Code boxes, type and confirm your new 

password. 

5 Click Save. 

IMPORTANT You must click the Save button to save your new password. 

6 Click Apply, and then click OK. 

Creating a Voice Message 

Once the client software is installed on your workstation and the server settings are configured in Unified 

Messaging Connection Manager, you can access the voice messaging and fax retrieval features through 

your IBM Notes mail program. 

To create a new voice message: 

1 With IBM Notes running, open the voice messaging form using one of the two following options: 

 From the Toolbar, click the New Voice Message icon. 

 From the Menu bar, click Create, and then Voice mail. 
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2 The voice messaging form appears. 

 

3 On the voice message form: 

a Click To and select the recipient(s)’ name(s) from the displayed address list. 

b Click the Record button to begin recording your message using your selected recording 

device (telephone or computer). 

c Click the Stop button to end recording. 

d Click the Play button to review your message. 

e Click Send to send the voice message. 

For more specific information on recording and playback options, see the Unified Messaging 

Connection Manager online help. 

Playing Voice Messages and Viewing Fax Messages 

A speaker icon indicates voice messages in IBM Notes. A fax icon indicates fax messages in IBM Notes. 

To play a voice message or view a fax message: 

1 Double-click the received message.  

 If the message is a voice message, the voice messaging form appears. 

 If the message is a fax only, the fax viewer opens automatically, displaying the fax message over 

the voice messaging form. 

 If the message has both fax and voice components, only the voice messaging form appears. 

2 Depending on the message type, perform one of the following tasks: 
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 If you want to listen to the voice message: 

Click Play on the voice messaging form recorder bar to begin playing the message. 

NOTE Your mailbox may be set to play messages automatically, so you may not need to click 

Play. 

 If you want to view the fax: 

Click the View Fax button to launch the fax viewer. When accessing fax messages only, the 

viewer will automatically open the fax document in some cases. 

Replying to a Voice Message 

NOTE Any changes you make to volume, speed, and playback settings will be saved for your next 

session. 

To reply to a voice message with a voice message:  

1 Open the voice message to which you want to reply.  

2 Click the Voice Reply button.  

 

The voice messaging form opens. The To box will indicate the name of the person to whom you are 

replying.  

3 Click the Record button and begin recording your message. Your telephone will ring if you are 

using it as the selected recording device. Pick up the handset and speak into the handset to begin 

recording; otherwise speak into the microphone.  
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4 To stop recording, click the Stop button.  

5 To review your message, click the Play button.  

6 Click Send. The original voice message is not sent with the reply.  

Forwarding a Voice Message 

NOTE Unified Messaging for Lotus Notes/Domino Server only enables you to view, reply to, and forward 

fax messages. Fax message generation is performed through the Enterprise Fax Server. 

To forward a voice message:  

1 Open the voice message that you want to forward.  

2 Click the Voice Forward button.  

 

3 The voice messaging form opens.  

4 Click To and select the recipient(s)’ name(s) from the displayed address list.  

5 If you want to record an introduction to your forwarded message, click the Record button and 

begin recording your message. If not, skip to step 8. 

 

Your telephone will ring if you are using it as the selected recording device. Pick up the handset 

and speak into the handset to begin recording; otherwise speak into the microphone.  

6 To stop recording, click the Stop button.  

7 To review your message, click the Play button.  
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8 Click Send.  

Telephone User Interface Features 

The Telephone User Interface (TUI) features provided by MiCollab AM Unified Messaging covered in this 

section include: 

 Replying to an E-mail message by telephone 

 Forwarding an E-mail message with voice comments 

 Faxing an E-mail message to someone else 

 Printing an E-mail message by forwarding it to a fax machine 

 Selecting E-mail messages for group processing 

Replying to an E-mail Message by Telephone 

You can reply to an E-mail message with a voice message by telephone, rather than waiting to access the 

E-mail system. 

To reply to an E-mail message by telephone: 

1 Access your Subscriber mailbox from a telephone. 

2 While listening to the desired E-mail message, press -8- to reply. 

3 If prompted, enter the mailbox number of the person to whom your voice message should be sent. 

4 Press -2- to start recording your message. 

5 Press -2- to stop recording. 

6 Press -5- to send your reply. 

7 To send your reply to someone else, press -1-; otherwise, press -9-. 

Forwarding an E-mail Message to Someone Else 

You can fax an E-mail message to someone else by forwarding it to the appropriate Fax Delivery mailbox. 

However, to use this feature, MiCollab AM must have access to either an XMediusFAX fax server or a 

RightFax Enterprise fax server. 

To fax an E-mail message to someone else: 

1 Access your Subscriber mailbox using a telephone. 

2 While listening to the desired E-mail message, press -2- to forward it. 

3 Enter the appropriate Fax Delivery mailbox number for the fax machine you want to use. 

4 If you specified a Fax Delivery mailbox that prompts for a telephone number, follow these steps: 

a Specify the telephone number, and then press -#-. 
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b Confirm that the number is correct by pressing -1-. 

c Identify your fax by entering your extension or telephone number and press -#-. 

d Confirm that the number is correct by pressing -1-. 

5 When prompted to record an introduction, press -5- to send your message. 

Do not record an introduction when forwarding an E-mail message to a fax machine. Press -5- to 

send your message immediately. 

6 To forward the message to another fax machine or someone else, press -1-; otherwise, press -9-. 

Printing an E-mail Message on a Fax Machine 

You can print an E-mail message by forwarding it to a fax machine. MiCollab AM allows you to print at 

any time and at any fax machine. However, to use this feature, your MiCollab AM System Server must 

have access to either an XMediusFAX fax server or a RightFax Enterprise fax server. 

To print an E-mail message: 

1 Access your Subscriber mailbox using a telephone. 

2 While accessing the desired E-mail message, press -2- to forward it. 

3 Enter the appropriate Fax Delivery mailbox number for the fax machine you want to use. 

4 If you specified a Fax Delivery mailbox that prompts for a telephone number, follow these steps: 

a Specify the telephone number, and then press -#-. 

b Confirm that the number is correct by pressing -1-. 

c Identify your fax by entering your extension or telephone number and press -#-. 

d Confirm that the number is correct by pressing -1-. 

5 When prompted to record an introduction, press -5- to send your message. Do not record an 

introduction when forwarding an E-mail message to a fax machine. Press -5- to send your message 

immediately. 

6 To forward the message to another fax machine or someone else, press -1-; otherwise, press -9-. 

Selecting E-mail Messages for Group Processing 

The MiCollab AM group selection feature saves you time and effort by letting you handle messages in a 

group. For example, you can select your E-mail messages and forward them to a nearby fax machine for 

printing. Messages lose their selected status once you exit MiCollab AM. 

To select E-mail messages for group processing: 

1 Access your subscriber mailbox using a telephone. 

2 While accessing the desired E-mail message, press -0-, and then press -1- to select it for group 

processing. 

3 Continue to access and select E-mail messages following the instructions in Step 2.  
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4 Press -*- to return to the main menu 

5 Press -6- to access selected messages. The following menu options are available: 

 To forward all selected messages, press -2-. 

 To discard all selected messages, press -4-. 

 To save all selected messages, press -5-. 

6 Press the key for the desired action, and then follow the voice prompts. 
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This section covers the tasks required to install MiCollab AM into a customized mail template.  

IMPORTANT The procedures in this section provide a basic method and details to the Notes/Domino 

administrator about the process. A Notes/Domino administrator who is familiar with 

template customization should perform these tasks. 

  There is no direct Customer Support for the following procedures because they vary from 

site to site. Thus, proceed with caution. 

Editing Your Customized IBM Notes Mail Template  

When you load the CXInstall.nsf database, the installation signs it with the Notes/Domino ID of the user 

that does the installation automatically. 

If this is not your template signing authority, you need to manually sign the template with that ID. This 

action ensures that this template contains the same signature as should be contained in the user’s 

Execution Control List (ECL). Otherwise, the user is prompted to cross-certify this database signature. 

To edit your customized IBM Notes Mail Template: 

IMPORTANT These procedures must be performed at the administrator’s workstation. 

  The administrator’s user ID must be set in the Server document on the Mail server, as 

applicable, so that the ID can be used to Run unrestricted IBM Script/Java agents and 

Create new databases. 

  Verify these settings before proceeding. Once you have performed these procedures, 

copy the new template to every Domino Server that currently contains a customized 

mail template. 

1 Insert the MiCollab AM Installation Media into the appropriate workstation drive. 

2 Copy the installation database, CXInstall.nsf, from the drive where the installation media is inserted 

to the Notes\Data folder on the workstation’s disk drive. 

 If you are installing the U.S. edition: 

Copy the database from the …\Client Installs\Desktop Suite for Domino\Templates\Install\ 

USA folder on the installation media. 

 If you are installing the World edition: 

Appendix B: Installing MiCollab AM into 

a Customized IBM Notes Mail Template 



Appendix B: Installing MiCollab AM into a Customized IBM Notes Mail Template   66 

Copy the database from the …\Client Installs\Desktop Suite for Domino\Templates\Install\ 

World folder on the installation media. 

3 From the Windows taskbar, click (or right-click) the Start menu, and select Run. The Run dialog 

box appears. 

4 In the Open textbox, specify the full path and filename of the installation database you copied to 

the workstation in Step 2.  

5 Click OK to continue. 

6 At the MiCollab AM dialog box, click Next. 

7 If a dialog box displays to state that this template was stamped by Mitel Software 

Development, click Trust Signer. 

8 At the bottom of the Notes Installer dialog box, click My templates are customized. 

9 In the UM Objects list of templates, double-click the mail template for the version of IBM Domino 

Server you are using.  

10 From the Install Files dialog box, double-click the icon for the template you selected. 

11 In the Attachment dialog box, click Launch. 

A Unified Messaging Objects list appears and displays the names of all template objects available 

in the MiCollab AM Unified Messaging object template. 

12 Make a copy of your company’s customized mail template. 

13 Be sure to uncheck the setting Database file is a master template in Database Properties for 

your backup template to prevent conflicts. 
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14 Using Notes Designer, open the template copy that you created in Step 12. 

IMPORTANT Do not open your original template. 

15 In the template copy that is currently open in Notes Designer, delete all design elements in 

common with the Unified Messaging Objects list. 

16 Save the template copy, and then open an instance of it in the IBM Notes Client program. 

17 Verify that the Unified Messaging Objects list is open to the default view, open the Edit menu, 

and then select Select All. A check mark should display next to every design element shown in this 

view. 

18 In the Unified Messaging Objects list, open the Edit menu, and then select Copy. 

19 In any open instance of the template copy (either the one open in Notes Designer or the one open 

in the IBM Notes Client), open the Edit menu, and then select Paste. 
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IMPORTANT In the next step, you must close all instances of both programs to ensure that the 

new MiCollab AM Unified Messaging template objects are added to the new 

template copy. 

20 Close all open instances of the IBM Notes Client and Notes Designer. 

21 After you are sure the template copy is working properly, archive your original customized mail 

template. 

Adding the MiCollab AM Account to the Mail Template 

To create new Subscriber mailboxes without having to add the MiCollab AM account to each new 

mailbox, add the account to the New template. 

To set the user name to inherit to every database created with this template, use the format user 

name/organization. This account should also contain Server and Admin groups in the Access Control 

List (ACL) for the template. 

For example: 

An account for a marketing department might be marketing/acme. 

If you choose to add the MiCollab AM account to the New template, you must also update the ACL for 

the template so that the account has an access level of at least Editor – at Manager, if the MWI feature is 

installed – with Delete documents and Create personal agents privileges enabled. 

Updating Subscriber Mailboxes 

After updating the mail template, you must also update each Subscriber mailbox by adding the MiCollab 

AM mailbox user account to each existing subscriber mail file. This account must appear in the Access 

Control List (ACL) with Manager and Delete privileges. The account is in the format user 

name/organization. 

If E-mail Access installation is complete, this process may already be complete.  

Refreshing the Design Manually 

To make the updated template immediately available in all subscriber’s mailboxes, run the Domino 

Server’s design refresh process, as detailed below.  

After the design is refreshed, subscribers can access the new template for voice messaging and fax 

retrieval, along with the IBM Notes’ standard mail utilities. 

IMPORTANT This procedure works only if the updated template has the same template name as its 

predecessor. 

  If the new template has a different template name, then you must deploy the new 

template by upgrading the user’s mail files as discussed in the topic, Upgrading a User’s 

Mail Files to Use Unified Messaging Templates on the IBM Domino Server. 
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To refresh the design manually: 

Enter the following command in the server console window: load design. 

IMPORTANT Always use caution when using the Load command. If you are unfamiliar with the use of 

this or any other Domino Server command, consult the IBM Domino online Help files 

for more information.   
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To function properly, the IBM Notes interface calls components of the IBM Notes client to communicate 

with the IBM Domino Server. These required components are written as an application program and not 

as a Windows Service. 

Therefore, if anyone uses the Close all programs and log on as a different user option on the MiCollab 

AM platform, the operating system automatically shuts the IBM Notes components down. If a subscriber 

attempts to log on to a MiCollab AM mailbox after this happens, MiCollab AM cannot present the 

subscriber’s new E-mail messages. Subscribers are not informed that E-mail Access is unavailable. 

To restart the IBM Notes components, you must shut down and restart MiCollab AM. 

To prevent this situation from occurring and preserve E-mail Access, we recommend that the domain 

name\MiCollab AM account be logged on continually on the MiCollab AM System Server platform. To 

secure MiCollab AM and prevent unwanted access, you should use the Lock Computer feature of 

Windows Server. 

IMPORTANT In a Domino cluster environment, be sure that each messaging server has a profile and is 

enabled on the E-Mail tab of MiCollab AM Configuration. 

Configuring the Cache Size 

The cache size speeds up telephone access to messages stored on the Domino Server. Increase the cache 

size if the following message displays in the Event Viewer Application log more than once a day: External 

Mail Cache purged. 

Configuring the cache size for IBM Notes requires the MiCollab AM System Server to be shut down.  

NOTE If MiCollab AM is deployed as a hosted solution on the cloud, contact your server administrator 

to configure the cache size for IBM Notes. 

To configure the cache size for IBM Notes: 

1 Log on to the MiCollab AM System Server using the MiCollab AM Service account. 

2 Open MiCollab AM Configuration and select the Main tab. 

3 If the system is running, click Shutdown. Wait until Current Status changes to Stopped.  

4 Click the Tenant tab, select a tenant, and then click the Edit button.  
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5 Set the E-Mail Cache Size (Mbytes) to a value between 10 and 500 megabytes (MB), and then 

click OK. The default is 200 MB. 

6 Click the Main tab, and then click Startup to restart MiCollab AM. 
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MiCollab AM Unified Messaging provides the following two automated methods for installing client files 

on subscriber workstations from a network share: 

 Push installation, in which an administrator starts the installation routine and the subscribers are not 

involved in it. 

 Pull installation, in which subscribers receives a link or path to the installation routine and start it 

themselves. 

This section describes both types of installation and discusses the necessary command line syntax for 

deploying them. 

NOTE After the installation, the workstation will need to be restarted. 

NOTE Both the push and pull installation cases require files generated via the administrator install (-a 

switch). This step must be run on the installation image before the installation may be launched. 

Push Installation 

A push installation can be either attended or unattended, but all subscribers’ computers must be on and 

connected to the network. Both attended and unattended push installs rely on third-party push-

installation software packages, all of which allow you to enter the name of an executable with command 

line arguments to run on the client machine.  

NOTE For a single tenant system, you can use either the Mailbox number or the Username for the 

Telephony Server Login. 

The following example shows typical command line syntax to perform an attended push install for a 

subscriber on a single tenant system with a mailbox number or username of 1234 and extension 5678. All 

other install values would come from the Admin.ini parameter file, which the administrator initially 

configured during setup. 

Executable: setup.exe 

Command line arguments: -vAdmin.ini –b1234 –u5678 

The following example shows typical command-line syntax for an unattended push install supporting a 

subscriber on a single tenant system with a mailbox number or username of 1234 and extension 5678. All 

other installation settings come from the Admin.ini file. 

For an unattended push install (also called a silent install), you must include the -s switch. The silent install 

will use the response file (setup.iss) generated via the administrator install (-a switch) as the input file to 

guide the setup. The administrator install must be run in a prior step in order to properly configure the 
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setup installation for silent installation and configuration. The -s switch must always be the last argument 

on the command line. Refer to Table 7 for a complete list of valid command line arguments. 

Executable: setup.exe 

Command line arguments: -vAdmin.ini –b1234 –u5678 –f1fullpath -s 

NOTE In both attended and unattended installs, you can omit the -b1234 & -u5678 arguments to make 

the install work for a group of users. Although the installation completes properly, subscribers 

cannot use MiCollab AM Unified Messaging until they enter their mailbox and extension numbers 

in Unified Messaging Connection Manager. 

Pull Installation 

A pull installation is always attended; a subscriber must be present to start it.  

To set up a pull installation for a group of subscribers, the administrator must provide a copy of the 

shortcut file UM Install.lnk to each user in the group. The administrator creates this file as part of the 

administrator setup process and places it on the network share with the other install files. 

An administrator can distribute the shortcut file to the subscribers in one of two ways: 

 Use whatever pull installation software the customer has to place it on the subscribers’ desktops. 

 Send it to all customers as an E-mail attachment. 

The subscriber then runs the file to begin the installation. The file is configured to invoke the following 

command line: 

setup.exe –vAdmin.ini  

In this command line, Admin.ini is the name of the parameter file created during administrator setup. 

Command-Line Syntax 

The following table lists the valid command line arguments for both push and pull installations. 

NOTE If you prefer, you can omit the -v switch and include the arguments in this table as switches on 

the command line. 

IMPORTANT The setups have a built-in -r switch to record the installation; however, the generated 

response file (setup.iss) from this switch is incompatible with the running of these 

installation types and should not be used. 

Table 7. Valid Command Line Arguments 

Argument Description 

-? Displays the usage help dialog of the command line parameters and values 
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Argument Description 

-a Performs an administrator install. When this switch is specified, the setup file is created 

in the same directory that contains the file Admin.ini.  

Do not use this switch with the -s switch. 

-b The username or mailbox number for single tenant systems.  

For example: 

–b1234 where the mailbox is 1234  

-f1 The full path to the response file, including the filename. The response file is required 

for silent installs. A default response file is created during the administrator install and is 

always called setup.iss. 

NOTE The full path cannot contain quotes or any space characters in the path. 

Here is an example of a working command: 

For example: 

Setup.exe -vAdmin.ini –b1234 –u5678 –f1D:\UMClientPushInstall\setup.iss –s 

-h The MiCollab AM System Server name.  

For example: 

–hCallXpr1 where the MiCollab AM System Server is CallXpr1 

-i The record device. Values are s for sound card; and t for telephone. 

-j The playback device. Values are s for sound card; and t for telephone. 

-k Is an install OKI driver override. Values are y for Yes; and n for No. 

-l Auto-play setting. Values are a for Always; u for New/Unread; and n for Never. 

-n Record message format. Values are m for Mu-Law; a for A-Law; p for Linear PCM; d 

for OKI ADPCM; and g for GSM 610. 

-o Override personal settings always. Values are y for Yes and n for No. 

-p The protocol. Values are t for TCP/IP; and n for Named Pipes. 

-s Silent install. This should appear as the last command line argument. 

-u Extension.  

For example: 

–u5678 where your extension is 5678 
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Argument Description 

-v Administrator parameter file name.  

For example: 

-vAdmin.ini (the default) 

This switch cannot be used to set the path where the file resides. 

-w Record non-message format.  

Values are m for Mu-Law; a for A-Law; p for Linear PCM; d for OKI ADPCM; and g for 

GSM 610. 

-y Client install path.  

For example: 

–yc:\Program Files\UM 

Here is an example command line and what it represents: 

For example: 

Setup –hcallxpr1 –b1234 –pT –u5678 –iT –jT –kN –lU –nM –wM –yc:\UM 

                                                                             

 The name of your MiCollab AM System Server is callxpr1. 

 Your mailbox is 1234 and extension is 5678. 

 You are using TCP/IP for your protocol. 

 Your playback and record devices are telephone. 

 Is not an install OKI driver override. 

 You want to auto-play only the new or unread messages. 

 The record message and record non-message formats are Mu-Law. 

 The default client install path is C:\UM. 

Using the Diagnostic Files 

Because push and pull installations occur in your absence, you need some sort of evidence that the 

installation was completed correctly. 

To provide you that evidence, the setup program creates a diagnostic file in the topmost directory where 

the software was installed. The name of the diagnostic file indicates how the installation concluded. 

Table 8. Installation Conclusion Steps 

If the file name is… Then… 

UMInstallSuccess.txt The installation completed successfully and no further action is required. 
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If the file name is… Then… 

UMInstallReboot.txt The installation completed successfully, but the computer must be restarted 

before the software can be used. 

UMInstallErr.txt The installation encountered problems, which the file describes. 

If the UMInstallErr.txt file exists, it contains one or more error codes that explain why the installation 

could not complete successfully. The following table shows the codes that can help you troubleshoot the 

installation yourself; if the file contains other codes, contact Mitel Technical Support for assistance. 

Table 9. Troubleshooting Codes 

Code Error Message Explanation 

110 User cancelled install 

(On Cancel event) 

A user interrupted the setup program as it was installing the 

software.  

111 User cancelled un-installation A user interrupted the setup program as it was removing 

software. 

112 Invalid file, 

CRC error encountered 

The setup program could not match the checksum given for 

an installed file, indicating that the file is corrupt.  

 If you have installed the setup program and its 

associated files to a shared directory on your network, 

verify that all of the files were copied correctly. 

 If you are installing from the MiCollab AM Installation 

Media, contact Mitel Technical Support. 

113 File reported an error during 

file copy 

The setup program could not copy a file successfully.  

Verify the following: 

 The destination folder (or its parent folder) is shared. 

 The account running the setup program has permission 

to modify it. 

 None of the files is marked read-only. 

115 Locked file was encountered The setup program could not copy a file successfully 

because it would need to replace a file that was in use at the 

time it ran.  

Make sure that no one has any files open in the directory 

where you are installing MiCollab AM Unified Messaging. 

119 Error occurred attempting to 

process the command line 

parameters 

The setup program could not understand all of the 

command line arguments it was given. 

Check the syntax of the command line you are attempting 

to use to install MiCollab AM Unified Messaging. 
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Any time maintenance is performed on the Domino Server, it affects the ability of Unified Messaging to 

function normally. In sites that have multiple Notes/Domino, maintenance on a single server can also have 

an undesired effect. 

While work is being performed on the Domino Servers, the effect on MiCollab AM results in new voice 

mail messages being unavailable to the subscriber until normal Domino Server operation resumes. 

The following procedure places MiCollab AM Unified Messaging in maintenance (Store down) mode. 

Subscribers can use the TUI to log on to MiCollab AM and check for messages that were received during 

the maintenance period. Any MiCollab AM messages already moved to the Domino Server’s unified 

message store are unavailable through the TUI until normal operation between the servers is restored. 

Voice messages residing on MiCollab AM are unavailable through the IBM Notes Client. Once normal 

operation is restored, MiCollab AM moves the new messages still residing on it to the Domino Server, and 

all messages become available through the TUI or the IBM Notes Client. 

The interval between full restoration of Service and new message availability may be up to one hour to 

prevent MiCollab AM from sending too many messages at once to the Domino Server. 

Enabling/Disabling E-mail Access Using MiCollab AM 

Admin Configuration 

To disable a messaging server profile immediately: 

1 Open MiCollab AM Admin > Configuration > System and select the E-mail tab. 

2 Select a messaging server profile, and then click Edit. The Server Profile dialog box appears. 

3 Clear the Enabled checkbox, and then click OK to close the Server Profile dialog box. 

4 Click Apply to save the change. The messaging server profile is now disabled. 

To enable a messaging server profile immediately: 

1 Open MiCollab AM Admin > Configuration > System and select the E-mail tab. 

2 Select a messaging server profile, and then click Edit. The Server Profile dialog box appears. 

3 Select the Enabled checkbox, and then click OK to close the Server Profile dialog box. 

4 Click Apply to save the change. The messaging server profile is now enabled. 

Appendix E: Enabling/Disabling E-mail 

Access During System Maintenance 
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To disable a messaging server profile for server maintenance: 

1 Open MiCollab AM Admin > Configuration > System and select the E-mail tab. 

2 Select a messaging server profile, and then click Edit. The Server Profile dialog box appears. 

3 In the Maintenance section, select the Enabled checkbox. 

4 In the Start box, select a time to start server maintenance. 

5 In the Stop box, select a time to end server maintenance. 

6 Click OK to save the changes to the messaging server profile, and then close the Server Profile 

dialog box. 

7 Click Apply to save the changes. 
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